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2 AARENET TRAINING oor{gp

INTRODUCTION & MOTIVATION

» This training covers the topics:

Description of the anSwitch V7 REST API.

The available REST methods and data formaits.
The configurable anSwitch V7 database objects.
Best practices for using the anSwitch V7 REST API.
Examples
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OVERVIEW ANSWITCH V7 REST API

aare
net)

» The REST API allows to configure the anSwitch V7 directly from a
customer relationship management CRM.

»  REST stands for: REpresentational State Transfer (For further introductory information, see this Wikipedia article)

b In a multi-tenant setup of an anSwitch V7 every tenant can have its own
CRM application that manages just the own resources.

b A PBX customer may have its own CRM application with just access to the
resources of the own PBX.

Tenant
5
B .
- | TenantCrRM Telephony Provider
Administrative PBX Customer A ——
personnel of the Tenant A
PBX Customer n REST AP %
C | Administrative personnel

PBXCampus | b= of the provider
A p Provider Administration CRM
(o GI’]SWI’;[Ch V7
- | Customer CRM for the own PBX 0 ‘ O ) "
Administrative PBX Administrator Portal GUI anSwitch V7 Administrator, Operator, Support
personnel of the

T Vi

T



https://en.wikipedia.org/wiki/Representational_state_transfer
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OVERVIEW ANSWITCH V7 REST APl FEATURES

» The anSwitch V7 configuration REST APl cover these general
features:

»  HTTP/HTTPS as transport protocol.
»  Security by:

) Individual login and authentication for each CRM application.
b Access only o the assigned resources.
) Secure data transfer by HTTPS.

» Various supported data formats are available for the
transfer: JSON, XML and CSV.
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VIA REST APl MANAGEABLE DATABASE OBJECTS

aare
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» OrgUnit
» Tenant
» PBX

» PBX Extension

» User

> User account
3 User role

» Address (phone number)

» Public numbers
» Private PBX numbers

» Terminal (phones)

» Phone type:
» anDesktop, an IP-Phone, anConnect
» 39 party SIP phone/terminal

» Location of registration

» Presence subscriptions

» Call Distribution

> Forward

» Advanced Call Distribution ACD
» Interactive Voice Response IVR
» Timetable
» Holiday
» Faxserver
» Pager/Intercom
» Audio File
» Pricelist & Rating & TopStop
»  Pricelist
»  Billing & Billing Limit
» Call Detail Record CDR
» Call Quality Record CQR
» Contact

> PBX contacts
» PBX extension user contacts
» Short numlbers
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VIA REST APl MANAGEABLE DATABASE OBJECTS

) 4
OrgUnit
OrgUnitAttribute
User
UserRole
UserAttribute
Address Contact
AudioFile
CDR BillingAccount
CQR BillinglLimit
Terminal
TerminalAttribute
Forward TimeTable Holiday
Location
. - TimeTableEntry
Subscription
Pricelist Acd
PricelistDestination AcdMember
PricelistTariffPlan AcdMenu

* For the bold framed objects examples
PricelistTariffEntry AcdRule are available in this document.
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WARNING = DIRECT ACCESS TO THE ANSWITCH V7 DATABASE!

= An exiternal CRM application that manages its assigned resources via the REST API has full control
over its accessible instances in the database of the anSwitch V7!

= Careless manipulations via the REST APl can destroy beyond repair!
(Only a DB restore could help eventually with all its other negative side effects.)
» Careless manipulations via REST APl can destroy the operational functionality of an instance,
e.g. PBX
» There is no check of the configured values of a property of an instance.
There is no built-in "undo".

= Code development for an external application and its testing should therefore definitely take
place either on a test anSwitch V7 or before the anSwitch V7 is put into operation.

GREAT POWER =» GREAT RESPONSIBILITY!
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SUPPORTED REST METHODS

» The following REST methods are supported:

» POST - Create anew instance.
» PUT - Modify an existing instance .
» GET - Retrieve data of an instance or a list of instances.

» DELETE - Delete an instance.
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URL REQUEST DEFINITION

» URL request definition:
https://DOMAIN_REST/rest/<OBJECT_KEY>/<INSTANCE |D>?<PARAMETERS>

A . N .

» IP-address with port | | Mandatory Object key Instance ID of the Optional
» Domain hame identifier for of the database parameters.
the REST API database

Examples
POST https://DOMAIN_REST/rest/orgUnits
PUT  https://DOMAIN_REST/rest/orgUnits/519
GET https://DOMAIN_REST/rest/orgUnits/519
GET https://DOMAIN_REST/rest/orgUnitsewhere=name.like('Provider A')&properties=id
GET https://DOMAIN_REST/rest/orgUnits/5192properties=name
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SUPPORTED DATA FORMATS

» The applicable data formats are:
JSO“ 9 iS The defaU" XML CSV is possible but not recommended

Examples:
{ <terminal> "Mobile — an IP-Phone",
"name" : "Mobile — an IP-Phone", <name>Mobile — an IP-Phone</name> "anlpPhone",523,113,fsdfgsdfgf?8ug00hzHJB
"type" : "anlpPhone", <type>anlpPhone</type> S.fvg56AS056
"orgUnitld" : 523, <orgUnitld>523</orgUnitld>
"userld": 113, <userld>113</userld>
"password": "fsdfgsdfgf98ug00hzHJBS", <password>fsdfgsdfgf?8ug00hzHJB</password>
"username": "fvg56AS056" <username>fvg56 AS056</username>
} </terminal>
JSON formatting rules apply: XML formatting rules apply. » The order of the properties must be
» White spaces and new lines are allowed. known/evaluated.
b String values (type varchar) must be » String values W|‘rlk'1 w”hl‘re spaces must be
double quoted ™. double quoted "....".
ou .q SR » The values must be separated by a
» Properties and their values must be comma ',
separated by a comma ',

) Example of the same GET request for receiving data in the different formats:
Json . PUT https://DOMAIN_REST/rest/terminals/308

XML: puT hitps://DOMAIN_REST/rest/terminals/308.xml

CSV: ‘ PUT https://DOMAIN_REST/rest/terminals/308.csv
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DEFINITION OF A POST & PUT REQUEST

» A POSTrequest creates a new Iinstance of an object.

» Example of a POST request, JSON formatted » Response
POST https://DOMAIN_REST/rest/orgUnits 200 OK
{ { A successful POST is confirmed with a 200 OK.
"name" : "PBX REST Test", "name": "PBX REST Test",
"type" : "pbx", "id": 519, € The ID of the instance is needed for later referencing.
"descripfion”: "PBX of company REST", "type": "pbx",
"parentld": 25 "parentld": 25,
} "description”; "PBX of company REST"
}

» A PUTrequest changes the value of a property of an instance.

» Example of a PUT request, JSON formatted » Response
PUT https://DOMAIN_REST/rest/orgUnits/519 200 OK
{ { A successful PUT is confirmed with a 200 OK.
"name" : "PBX 1234-abc-0001", Several the values of several properties of "name"; "PBX 1234-abc-0001",
"description” : "PBX of company A" an instance can be changed. "id": 519,
} "type": "pbx",
"parentld"; 25,
"description”: "PBX of company A"
}
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DEFINITION OF A GET REQUEST

» A GET Request retrieves data of an instance or a list of instances

» Example of a GET that retrieves all instances. » Response
GET https://DOMAIN_REST/rest/orgUnits 200 OK
‘ No body { The whole list of all instances is retfurned.
"orgUnits": | < Object name

{
"name": "PBX REST Test",

3
{

"name"; "PBX Company A",

11}
» Example of a GET that retfrieves of a defined » Response
instance.
GET https://DOMAIN_REST/rest/orgUnits/519 200 OK
‘ No body { All properties of an instances is returned.
"orgUnits": [ < Object name

{
"name": "PBX REST Test",

"id"; 519,
"type': "obx",
"parentld": 25,

1}
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DEFINITION OF A DELETE REQUEST

» A DELETE request deletes the instance.

» Example of a DELETE that retrieves an instances. » Response

DELETE https://DOMAIN_REST/rest/orgUnits/51% 200 OK
‘ No body No body

- There is no undol!

Prevent dead data in the database!

Make sure to identify other instances that
reference to this to delete instance!
= Consider what to do with any of this
eventually orphaned instances:
» Delete it too?
» Re-reference it to another
instance?
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OVERVIEW FILTER & SORT & LIMIT & SPECIFIC PROPERTIES

» Various parameters and parameter combinations can be used in a
GET request to obtain the desired data according to the
requirements..

4

Filter

Return only those instances whose property values match the given conditions.

Sort

Sort the found instances according the value of the defined instance property
ascending or descending.

Limit

Return only a defined range of instances.

Specific Properties
Return just the defined property and their values of an instance.
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OVERVIEW FILTER & SORT & LIMIT & SPECIFIC PROPERTIES

» Builld-up of GET request parameters:

GET https://DOMAIN_REST/rest/<OBJECT_KEY>?<FILTER>&<SORT>& <LIMIT>&<PROPERTIES>

T pp——
? &
Begin of GET request Logical AND of GET
parameters. parameter combinations.

» The order of the GET parameters is free
GET https://DOMAIN_REST/rest/<OBJECT_KEY>?<FILTER>&<SORT>&<LIMIT>
GET https://DOMAIN_REST/rest/<OBJECT_KEY>?<LIMIT>&<PROPERTIES>
GET https://DOMAIN_REST/rest/<OBJECT_KEY>?<SORT>&<LIMIT>&<FILTER>&<PROPERTIES>

Examples
GET https://DOMAIN_REST/rest/orgUnitsewhere=name.like('Provider A')&properties=id
GET https://DOMAIN_REST/rest/orgUnitsewhere=name.like('Front Desk').and(parentld.eq(26))
GET https://DOMAIN_REST/rest/cdrsewhere=accOrgUnitld.eq(28) &limit=5&ascending=id&properties=id,
destNumber,timeConnect,timeEnd,chargePublic
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FILTER INSTANCES
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» Filter the instances according

properties.
» The filter parameter:
where=<FILTER_CONDITIONS>
» The filter condition can be a single property or a
combination of properties with conditions.

» Examples:
» Search the tenant with property "name", the string must
match exactly "Provider A":
GET .../orgUnitsewhere=name.like('Provider A')

» Search the instances where:
* the property "name" begins with "Bo" and has any
number following characters.
* and the property "telNumber" starts with "079" and has
any number following digits.
GET .../addressesewhere=name.like('Bo%').and(telNumber.like('079%'))

» List all CDR of a PBX between a start and an end
date/time:
GET .../cdrs2accOrgUnitld.eq(28).and(fimeStart.ge(1696111200000))
.and(timeEnd.le(1698793200000))

» SQL like operators are supported.

» Boolean operators

4

4
4
4

» Number operators

VvV vV vV vV vV vV vV v v v

eq() =
ne() I=

and() &&

or() | |

eq() =
ne() I=
I()

at()

le()

ge()

like()
notLike()
in(<list>)
notln(<list>)

IV INV A

» String operators

v v v v v Vv

eq() =
ne() I=
like()

notLike()
in(<list>)
notln(<list>)

equal

not equal
logical AND
logical OR

equal

not equal

less than
greater

less or equal
greater or equal
LIKE

NOT LIKE

IN

NOT IN

equal
not equal
LIKE

NOT LIKE
IN

NOT IN

» SQL like Regex are supported!
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SORT INSTANCES

» Sort the instances according a property value.

» The sort parameter:
ascending=<PROPERTY_NAME>
descending=<PROPERTY_NAME>

» Examples:
» Search the contacts of a PBX Extension where:
* the property "name" begins with "B".
* and sort the list ascending according the property "name".
GET .../ contactsewhere=orgUnitld.eq(26).and(name.like('B%')) &ascending=name

» List the CDRs of a PBX where:
* The CDRs are between a start and an end date/time.
* and sort the list descending according the property "timeStart ".
GET .../cdrs2 where=accOrgUnitld.eq(28).and(timeStart.ge(1626111200000)).and(timeEnd.le(1698793200000))&descending= timeStart
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LIMIT INSTANCES
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» Limit the listed instances according a range of instances.
» The limit parameter:

limit=<RANGE>
limit=<OFFSET>,<RANGE>

» Examples:

»

Search the contacts of a PBX Extension where:

* the property "name" begins with "B".

* and sort the list ascending according the property "name".

* and limit the list o the first 5 occurrences.

GET .../ contactsewhere=orgUnitld.eq(26).and(name.like('B%')) &ascending=name&limit=5

List the CDRs of a PBX where:
* the CDRs are older than defined start date/time.

* and limit the list to 200 CDRs with an offset of 100 (CDR instances between 100 and 300 will be returned).

GET .../cdrsg2where=accOrgUnitld.eq(28).and(tfimeStart.ge(1696111200000)) &limit=100,200

» Get the first 100 CDRs:
GET .../cdrsgwhere=accOrgUnitld.eq(28).and(fimeStart.ge(1696111200000)) &limit=100




24 FILTER & SORT & LIMIT OF GET REQUEST RESULTS oor{gi')

SPECIFIC PROPERTIES

» Limit the returned properties of an instance according a list of property names.

» The specific properties parameter:
properties=<PROPERTY_NAME>
» Separate a list of properties with a comma.

» Examples:
» List the names and IDs of all PBX's of a tenant:
* the property "name" begins with "B".
* and sort the list ascending according the property "name".
* and limit the list o the first 5 occurrences.
GET .../orgUnitsewhere=parentld.eq(4).and(type.like('pbx')) &properties=name,id

» List the contacts of a PBX with their name, dialable destination number and short number:
GET .../contactsewhere=orgUnitld.eq(26) &properties=sname, telNumberNormalized,shortNumber

» List the name and description of a PBX:
GET .../orgUnits/5192propertiessname,description 200 OK
{

"orgUnits"; [
{

1}
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VIA REST APl MANAGEABLE DATABASE OBJECTS

) 4
OrgUnit
OrgUnitAttribute
User
UserRole
UserAttribute
Address Contact
AudioFile
CDR BillingAccount
CQR BillinglLimit
Terminal
TerminalAttribute
Forward TimeTable Holiday
Location
. - TimeTableEntry
Subscription
Pricelist Acd
PricelistDestination AcdMember
PricelistTariffPlan AcdMenu

* For the bold framed objects examples
PricelistTariffEntry AcdRule are available in this document.
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OVERVIEW INSTANCE PARAMETERS
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» Explanation of the upcoming parameter lists
Property name of the database | |Database data type: Allowed value:
Primary key : Unigue id of the object [T-n] : Number out of a range until
INT : Number, 0 - 4294'967'295 max. of n (max. of the type)
BIGINT : Number, O - 184'467'440'737'709'551'615 String : Free string e.g., a name
VARCHAR : String [max. length] [a | b | c]: List of allowed strings
B Prope ame | Db Darta De Allowed Value ReEMmAa

Request URL with https:/DOMAIN_REST/rest/orgUnits

<OBJECT_KEY>.

Portal Ul > Menu: PBX > Sub-menu: Organization Units

Unigue OrgUnit-Id, assigned ...

Portal Ul menu id Primary key [1-n]
path for name VARCHAR [45] String
configuring an ‘
. type VARCHAR [45] [ system | tenant | pbx | extension |
instance.
department ]
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HOW TO GET INFORMATION ABOUT MISSING DB OBJECTS AND
UNKNOWN PROPERTY VALUES®

4

The documentation about database objects and their valid
property values may lag when a new anSwitch V7 version is
available.

Contact the Aarenet support and place a helpdesk ficket about
the missing information.

Hint for how to get unknown valid property values!
b For getting valid values of e.g., new or extended properties proceed as

following:

1. Via the Portal Ul configure the requested parameter in an instance.
2. Read out the instance via the REST API.
3. Checkin the returned data the value of the corresponding property.
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OBJECT-KEY: ADDRESSES

DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/addresses

Portal Ul > Menu: PBX > Sub-menu: Public Numbers
Portal Ul > Menu: PBX > Sub-menu: PBX Settings > Tile: Public Numbers
Portal Ul > Menu: PBX > Sub-menu: Extensions > Extension Setup > Tile: Number

id Primary key [1-n] Unique Address-Id, assigned automatically by the DB at creation time

name VARCHAR [45] String Displayed name at the called side

number VARCHAR [45] String Public PSTN or private phone number

orgUnitld INT [1-n] OrgUnit-Id of the PBX Extension this address belongs to

locationAddrId INT [1-n]

publicAddrId INT [1-n] The public PSTN phone number which is the DDI number of the private number
flags INT [0-n]

scopeOuld INT [1-n] OrgUnit-Id of the PBX this address belongs

userId INT [1-n] User-Id of the user account this address is associated with

validFrom BIGINT 0-n Unix time stamp this address is valid from

Must be exact to the milli seconds, e.g. 1634737080000

validuntil BIGINT 0-n Unix time stamp this address is valid until
Must be exact to the milli seconds, e.g. 1634737080000
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OBJECT-KEY: AUDIOFILES

DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/audioFiles

Portal Ul > Menu: PBX > Sub-menu: PBX Settings > Tile: On Hold Music

Portal Ul > Menu: PBX > Sub-menu: Extension Related Features > Tile: VoiceMail Box
Portal Ul > Menu: PBX > Sub-menu: Extension Related Features > Tile: Dial by Name

Portal Ul > Menu: PBX > Sub-menu: Extension Related Features > Link: Advanced Call Distribution ACD > Tile: Audio Files
Portal Ul > Menu: PBX > Sub-menu: Extension Related Features > Link: Interactive Voice Response IVR > Tile: Audio Files

id Primary key [1-n] Unique AudioFile-Id, assigned automatically by the DB at creation time
name VARCHAR [45] String Name of the audio-file
number VARCHAR [45] String Private phone number a VoiceMail Box message belongs to
duration BIGINT [1-n] Duration of the audio file in milli seconds
type VARCHAR [12] [ greeting | message | static | prompt]  "greeting" : Personal VoiceMail Box welcome
"message” : VoiceMail Box message
"static" : Audio file for ACD/IVR, PBX music on hold
"prompt" : Auto attendant — Dial by name
addressId INT [1-n] Address-Id this audio-file belongs to
time BIGINT [1-n] Unix timestamp of creation or upload of the audio-file

flags INT [0-n]
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OBJECT-KEY: CDRS

cdrs | Var Type [max Length] | Value | Remark
https:/DOMAIN_REST/rest/cdrs

Portal Ul > no page

NoTe For details about the available CDR fields, see the
training documentation:

"Rating & Call Detail Record CDR"
(doc id: training_as7_706_sys_rating_cdr)
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OBJECT-KEY: CONTACTS

DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/contacts

Portal Ul > Menu: PBX > Sub-menu: Contacts
Portal Ul > Menu: PBX Member > Sub-menu: Contacts

id Primary key [1-n] Unique Contact-Id, assigned automatically by the DB at creation fime
type VARCHAR [32] [ none | block] "block" : Incoming calls to this contact will be blocked

name VARCHAR [32] String Name of the contact

telNumber VARCHAR [32] String Phone number with local writing customs e.g.: "012 (345) 67 - 89"
telNumberNormalized VARCHAR [32] String Phone number with striped special and white characters e.g.: 0123456789

- This number will be dialed

shortNumber VARCHAR [32] String Short phone number of this contact
orgunitld INT [1-n] OrgUnit-Id this contact belongs to
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OBJECT-KEY: FORWARDS

DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/forwards

Portal Ul > Menu: PBX > Sub-menu: Extensions > Extension Settings > Tile: Number
Portal Ul > Menu: PBX > Sub-menu: Extension Related Features > Tile: Call Forwarding

id Primary key [1-n] Unique Forward-ld, assigned automatically by the DB at creation fime
addressId INT [1-n] Address-Id this forward belongs to
destination VARCHAR [45] Number Phone number or *#-code, e.g. *86300
type VARCHAR [8] [cfu | cfb | cfnr | cff] "cfu" : call forward unconditional
"cfb" : call forward if busy
"cfnr’ : call forward if not reachable
"cff" : call forward fallback
flags INT [0-n]
delay INT [0-n] Delay in milli seconds, e.g. 1'500 (equals 1.5sec)

timePattern VARCHAR [32] String
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OBJECT-KEY: HOLIDAYS

DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/holidays

Portal Ul > Menu: PBX > Sub-menu: Holidays

id Primary key [1-n] Unique Terminal-Attribute-Id, assigned automatically by the DB at creation time
orgUnitld INT [1-n] OrgUnit-Id of the PBX or department

name VARCHAR [45] String Name of the holiday

day INT [1-31] Number of day

month INT [1-12] Number of month

year INT %% Number of year, e.g. 2023
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OBJECT-KEY: LOCATIONS

DB Property DB Data Type | Allowed Values Remark

Name
https:/DOMAIN_REST/rest/locations

Portal Ul & none

id Primary key [1-n] Unigue Location-Id, assigned automatically by the DB at creation time
terminalld INT [1-n] Terminal-Id this location belongs to
addressId INT [1-n] Address-Id this location belongs to
ip VARCHAR [45] String

port INT [1-n]

contact VARCHAR [256] String

expires BIGINT [0-n]

endpointId INT [1-n]

userAgent VARCHAR [256] String

routel VARCHAR [256] String

route2 VARCHAR [256] String

flags INT [0-n]




36 MANAGEABLE DATABASE OBJECTS oonrgt)

OBJECT-KEY: ORGUNITS & ORGUNITATTRIBUTES

DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/orgUnits

Portal Ul > Menu: PBX > Sub-menu: Organization Units

id Primary key [1-n] Unique OrgUnit-Id, assigned automatically by the DB at creation fime
name VARCHAR [45] String Unique name
description VARCHAR [256] String Free descriptfion
type VARCHAR [45] [ system | tenant | pbx | extension |
department |
parentId INT [1-n] Parent OrgUnit-Id this OrgUnit belongs to

DB Property Name | DB Data Type | Allowed Values | Remark
https:/DOMAIN_REST/orgUnitAttributes

Portal Ul > Menu: PBX > Sub-menu: Organization Units > Tile: All Attributes
id Primary key [1-n] Unigue OrgUnit-Attribute-Id, assigned automatically by the DB at creation time

name VARCHAR [128] String Names & values , see separate lists:
» For PBX: see page "List of Important PBX 'OrgUnit Attributes' Names & Values"

value VARCHAR [128] String
orgUnitld INT [1-n] OrgUnit-Id this attribute belongs to
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LIST OF IMPORTANT PBX "ORGUNITATTRIBUTES" NAMES & VALUES

Name Value Remark

of OrgUnit Attribute

Portal Ul > Menu: PBX > Sub-menu: PBX Settings > Tile: Properties

maxExternalChannels [0-n] Default: 0, no limitations
maxServiceExtensions [0-n] Default: 0, no limitations
maxExtensions [0-n] Default: 0, no limitations
timezone "timezone[01-xx]" Example: UTC+3 = "timezone03"
dateformat dd.MM.yyyy

timeformat HH:mm

ctiDomain String CTlI-Domain of a PBX

Portal Ul > Menu: Operations > Sub-menu: Organization Units

cloudId String an IP-Phone Cloud ID

ctiDomain String CTI-Domain of a PBX

Portal Ul > Menu: PBX > Sub-menu: PBX Settings > Tile: On Hold Music

musicOnHoldId Number See examples "Upload an Audio-File for PBX Extension "Sales IVR™ how to get the ID of an audio-file.

NoTe The "Valid from" and "Valid until" is defined per
public number, see "Create the Public Phone
Numbers of PBX "PA-PBX-OB™
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OBJECT-KEY: TERMINALS

DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/terminals

Portal Ul > Menu: PBX > Sub-menu: Extension Related Features > Tile: Assigned Phones

id Primary key [1-n] Unigue Terminal-Id, assigned automatically by the DB at creation time
username VARCHAR [45] String SIP username
password VARCHAR [45] String SIP password = will be stored encrypted in the DB
orgUnitld INT [1-n] PBX Extension OrgUnit-Id this terminal belongs to
userId INT [1-n] User-Id this terminal belongs to
emergencylLocationId INT [1-n]
name VARCHAR [45] String Name of this ferminal > Choose a unique name. This helps for identification.
type VARCHAR [45] [ terminal type/profile ] Terminal type of predefined phone types:
"anConnect"
"anlpPhone"

"anlpDeskphone"
"yealinkT21PE2"
"snomD785"
"grandstreamGRP2613"

or terminal profile of a phone template:
"profile1"
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OBJECT-KEY: TERMINALATTRIBUTES

DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/terminalAftributes

Portal Ul > Menu: PBX > Sub-menu: Phones > Tile: Phone Setup
Portal Ul > Menu: PBX > Sub-menu: Phones > Phone Related Features > Tile: Phone Notification
Portal Ul > Menu: PBX > Sub-menu: Phones > Phone Related Features > Tile: Phone Keys

id Primary key [1-n] Unigue Terminal-Attriobute-ld, assigned automatically by the DB at creation time

name VARCHAR [128] String Names & values , see separate lists on
page "List of Important 'terminalAttributes' Names & Values"

value VARCHAR [128] String
terminalld INT [1-n] Terminal-Id this attribute belongs to
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LIST OF IMPORTANT 'TERMINALATTRIBUTES" NAMES & VALUES

Name Value Remark

of Terminal Attribute

Portal Ul > Menu: PBX > Sub-menu: Phones > Phone Setup

provisionOpt [ autoprov | manual | sip "autoprov": Configuration via redirections server and terminal MAC address
| clicktocall | anDesktop "manual’: Configuration of the config-download URL in the terminall
| anipphone | dectphone ] "sip": Configuration completely manual of the terminal
"clicktocall": Configuration for CTl base WebPhone or click-to-call button on a Web page
mac 00:00:00:00:00:00 MAC address needed with provisioning optiopn "autoprov"
oneTimeCode String Return value needed with "manual” e.g.: 469b40bc446bde4f
https://DOMAIN/cfg/469b40bc446bde4f701c9413fe35bb11d5acc345803baf0e.xml
webAdminname "admin"
webAdminPassword String Define the password string = will be stored encrypted in the DB
webUsername "user"
webUserPassword String Define the password string = will be stored encrypted in the DB
timezone "timezone[01-xx]" Example: UTC+3 > "timezone03"

Portal Ul > Menu: PBX > Sub-menu: Phones > Phone Related Features > Tile: Phone Notification

alertExternal [T-n] Ringtone number 1 — n, the max. number depends on the phone type

alertInternal [T-n] Ringtone number 1 — n, the max. number depends on the phone type

Portal Ul > Menu: PBX > Sub-menu: Phones > Phone Related Features > Tile: Phone Keys

fkey[n] [fkeyl - fkeyn] fkey[n]: n = 1 — the max. key number depends on the phone type
fkey[n] "speed/608/0987654321/Customer C" Speed Dial: [speed/Address-ID of PBX extension/destination/label]
fkey[n] "team/608/711/Front Desk" Team key: [team/Address-ID of PBX extension/destination/label]
fkey[n] "orbit/608/1/Park Call Park key: [orbit/Address-ID of PBX extension/1/label]

fkey[n] "line/609//711 Front Desk" Line key: [line/Address-ID of PBX extension the number belongs//label]
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OBJECT-KEY: USERS

aare
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DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/OrgUnits/users

Portal Ul > Menu: PBX > Sub-menu: Users

id Primary key [1-n] Unique User-Id, assigned automatically by the DB at creation time
name VARCHAR [45] String
firstName VARCHAR [45] String First name
lastName VARCHAR [45] String Last name
password VARCHAR [45] String Define the password string = will be stored encrypted in the DB
language VARCHAR [45] [en | de | fr| it | vi] Used language in the Portal Ul and default system notifications
"en" : English
"de" : German
“fr : French
“it" :Italian
Vi : Viethamese
email VARCHAR [45] string@string.string Valid email address = Must be unique in the anSwitch V7 system!
pin VARCHAR [45]
pinFails INT [0-n]
pinBlocked BIGINT [0-n]
passwordFails INT [0-n] Counter of failed logins
passwordBlocked BIGINT [0] >0] >0: the login is blocked
orgUnitId INT [T-n] OrgUnit-Id of the PBX Extension this user account belongs to
flags INT [0-n]
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OBJECT-KEY: USERROLES

DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/OrgUnits/userRoles

Portal Ul > Menu: PBX > Sub-menu: Users > Tile: Roles

id Primary key [1-n] Unique UserRole-Id, assigned automatically by the DB at creation time
userId INT [1-n] User Account Id this role belongs to
orgUnitId INT [1-n] OrgUnit-Id the user account with this role have access rights
role VARCHAR [45] [ "admin" | "operator" |"pbx" | "admin" : Administrator
"department" | "extension" | "rest"] "operator" : Operator

"pbx" : PBX Administrator

"department" : Department Administrator

"extension" : PBX Member

"rest" . REST API

flags INT [0-n]
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OBJECT-KEY: USERATTRIBUTES

DB Property Name | DB Data Type | Allowed Values | Remark

https:/DOMAIN_REST/rest/userAtftributes

Portal Ul > Menu: Operator > Sub-menu: Users > Tile: Attributes

Unigue Terminal-Attribute-ld, assigned automatically by the DB at creation time

id Primary key [1-n]
name VARCHAR [45] String Names & values , see separate lists on

age "List of Important 'userAttributes' Names & Values"
value VARCHAR [256] String — =

userId INT [1-n] Terminal-Id this attribute belongs to
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LIST OF IMPORTANT "USERATTRIBUTES" NAMES & VALUES

Name Value Remark

of Terminal Attribute

Portal Ul > Menu: Operator > Sub-menu: Users > Tile: Attributes

ctiDeviceId SiP:<INTERNAL_ CTl identification of an agent's PBX Extension which is monitored by a CTI application.
NUMBER>@<PBX_DOMAIN_NAME> Example: sip:21@pbx.customer.com
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INTRODUCTION OF ERROR HANDLING

» Host & Path Problems

» Host, server or service not reachable or doesn't reply

» Authentication Problems
» HTTP Status Code: 401 - Login is not possible

» OrgUnit & Instance Problems

» HTTP Status Code: 403, 404 = Instance doesn't exist or not allowed to write to

» Parameter & Value Problems

» HTTP Status Code: 404 - Parameters doesn't exist or not allowed to write o

Note The anSwitch V7 REST server doesn't return an error code or message when:
» A parameter was configured with an invalid value.
» The parameter was not configured at all.

= To solve this problem, see section "Best Practices":
How to Check a Newly Configured Parameter Value?




47 ERROR HANDLING & TROUBLE SHOOTING Ocnrgip

HOST & PATH PROBLEMS

» Host & Path Problems:

Error Message/Code or Meaning Action Remarks

Error Behavior

No response from the host The requested URL can't be reached. » Checkif the host IP
address is reachable via
Possible error messages from The service might be temporarily down, or the IP network
the REST client application: it may have moved permanently to anew  » Checkif the Portal
» connect ETIMEDOUT web address. component is running
IP_ADDRESS_HOST:IP_PORT » Checkif the URL, IP

address, IP ports and path
» Connection tfimeout are correct
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AUTHENTICATION PROBLEMS

»  Authentication Problems

Error Message/Code or \YTelqllgle Remarks

Error Behavior

Code: 401 Unauthorized » Check if the user exists
» Check if the user's role is
The username and/or password are "Rest API"
incorrect or doesn't exist. » Check the username and

password
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ORGUNIT & INSTANCE PROBLEMS

» OrgUnit & Instance Problems

Error Message/Code or \YTelqllgle Remarks
Behavior
Code: 403 The useris not allowed to write to this » Check if the user has the

instance. right to access the OrgUnit

The user is not allowed to create this

instance.
Code: 404 Instance does not exist » Check if the OrgUnit exists
» Checkif the instance
The OrgUnit or instance system-ID doesn't system-ID exists

exist or was deleted.
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PARAMETER & VALUE PROBLEM

» Parameter & Value Problem

Error Message/Code or \YTelqllgle Remarks
Behavior
Code: 400 Bad request b 2222 PUT with empty body:
{

Unsupported format }

Code: 403 Not allowed to write this instance » Checkif you have a typo
in the parameter name
The requested parameter (key) doesn't » Checkif the object type

exist of the instance exists
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TROUBLE SHOOTING

» Check as Administrator the Portal Log.

> Menu: Operator
> Sub-Menu: Logs
> Select Log Type: Portal
> Search for Regex Pattern, e.g.: RestServlet

» For object, instance and property problems check for key

words like:
» RestServiet
> REST API

» For CRM authentication problems check for key words like:
) Authenticator
b PermissionConfig
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IP CONNECTIVITY TO THE REST AP

1.  Make sure that the IP routing between the provider's and or
customer's CRM and the Public VolP segment of the anSwitch V7

Is end-to-end.

> The REST APl is accessible via the virtual IP address or a domain name, e.g.:
hitps://provider.com/rest

) Configure appropriate firewall policies: anSwitch REST - HTTPS, TCP port: 443

T

. HTTPS Side A: Data Center, Location A
Telephony Provider REST AP
s °°|

188 °°]] High
CRM application Availability
of the Telephony Provider ———— Public Voice Segment HA 1

2.2.2.0/16
v Virtual IP: 2.2.2.2 . K E
_ TronSfer ] Domain: pro\/iderlcom Slde B. DOTO Cenfer, LOCOT'O ‘1 B
/

Tenant/Customer Provider "\ QASIa High - ii

or

CRM application anSwitch V7 AvﬂilAOb;Ty
of a tenant or customer — Firewall
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CREATE A USER ACCOUNT FOR THE CRM APPLICATION
2. Via the Portal GUI, an administrator or REST Clent of fhe fenant
. e.g.: PBX Administration
operator configures a user account for OrgUnit: "Provider A"
the CRM application access with (AN Provide =T
read/write permissions for the desired REST API .
Oraunit OrgUnit: "PBXA"
rgunit. > PBX Setup = OrgUnit: "PBX B"

» Forexample: > PBX Setup

» A tenant must be enabled to manage its PBXs OrgUnit: "PBX C"

so the CRM needs access to OrgUnit "Provider > PBX Setup
A

» Create the user for the CRM access. s

> Menu: Operations S

> Sub-Menu: Users x ,

> The essenﬁcﬂ pgromefers needed for 'I'he P

configuration: o : poss o O parent O

Name |Vo|ue |Remork/ Example fﬁf‘lm ....... " — = =

E-mail Username, e.9.: f;::z:? S

crm@provider-a.com English «  Userblocked
Password .
Role Rest API

Access to OrgUnit
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PREPARE THE CUSTOMERS REST CLIENT

3. Setup the CRM application of the customer:
b Configuring the CRM application for

>
>

IP connectivity
REST authentication with the assigned user account credentials.

b Write code for managing the anSwitch V7 database via the REST AP

>

Writing code to handle the REST APl is not rocket science, but it must
be done with the care of an accountant.
= See the Warning!

It is strongly recommended to write and test the code on an anSwitch
V7 test system.

» Use a free REST application for experimenting with REST requests, see section ™Insomnia” a

REST Client Application".
» Consult the examples, see section "Example: Create PBX & PBX Extension” and following.
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HOW TO TEST NEW POST, PUT, GET AND DELETE REQUESTS?

» How to test new POST, PUT, GET and DELETE requestse

b For exploring and testing new requests for the configuration of parameters it
is recommended to use in the first place a 3rd party tool before writing
code for the own CRM system.

) For MS Windows the application "Insomnia” by Kong in its free version is fully
sufficient for testing purposes, see section
"Insomnia” a REST Client Application
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HOW TO CHECK A NEWLY CONFIGURED PROPERTY VALUE®?

» How to check a newly configured CRM Application anSwitch V7
property valuee

GET the current data of the instance

» In principle, it can be assumed that if a POST or EST—
PUT was confirmed with 200 OK, the data was 200 Ok out of the
. : i database.
saved correctly in the anSwitch V7 database. 2tum the data of the instance afabase
Save the original data
of the instance.
» Error messages are described in section "Error )
. . N Modify the value of the
Handling & Trouble Shooting requested property. PUT the modified data of the ins’rcnrmc:e>
Save the
. H dified dat
» If a CRM application wants to make sure the 200 OK A
process on the right side is recommended. Re U he data of the modified instancey | database.

Compare the returned instance

data with the original data.

Depending on the resulting

comparison:

» Display success.

» Display an error message.

» Automatically roll back by
PUT the original data.
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HOW TO GET PROPERTY VALUES®

» The data base objects, its properties and allowed values are
described in section "Manageable DataBase Objects".
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OVERVIEW "INSOMNIA"™ A REST CLIENT APPLICATION

»  For testing GET, POST, PUT, DELETE commands with the anSwitch
V7 REST APl itis a good idea to use a 3@ party product.

» For MS Windows the application "Insomnia” by Kong in its free
version is fully sufficient for testing purposes
hitps://insomnia.rest

» Itis easy to use!

» Download Insomnia installer
hitps:.//insomnia.rest/download



https://insomnia.rest/
https://insomnia.rest/download
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"INSOMNIA" A REST CLIENT APPLICATION

BASIC CONFIGURATIONS
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» Set preferences:

> Menu: Application
> Sub-Menu: Preferences
> Select tab: General

> Configure parameter:
» Raw template syntax: Disable it

“O Insomnia

Application File Edit View Window Tools Help

Insomnia Preferences - v202355

General Data Themes Keyboard Account Plugins Al

O use bulk header editor Reveal passwords

B 7 @)
Show variable source and value <~ @ O Raw template syntax

Autocomplete popup delay (ms) @

1200

Font
Indent with tabs O Font ligatures
Wrap text editor lines

Interface font @ Interface font size (px)
-- System Default -- 13

Text editor font @ Editor Font Size (px)
-- System Default -- 11

Editor Indent Size Text Editor Key Map
2 = Default

Request / Response

Validate certificates @ O Disable JS in HTML preview

«

o

<«




63 "INSOMNIA" A REST CLIENT APPLICATION oor{gi')

CONFIGURE ENVIRONMENT VARIABLES FOR THE CRM ACCESS

PROJECTS (4)

» Navigate to the collection: /@

> Select the "Personal Projects"

=] © E Collection
> Select the desired "Project”, e.g. Insomnia — Demo
. " . 01 PBXCTI
> Open the desired "Collection”, e.g. Demo — |

1 PBX Teams Zero-Touch

0 Test
© 11 minutes ago

» Configure the environment variables:

> At "Base Environment” click the "Gear" icon o\

> Configure the essential environment variables @ N BENE]
1 { @® Add Cookies
2 "as7Domain": "AS7_DOMAIN_NAME", < Insert the real domain name ‘
3 "authUsername": "CRM_UN", & Insert the real username e Vo
4 "authPassword": "CRM_PW" & Insert the real password
5 1}

> Click button: Close Manage Environments

_ Base Environment
Base Environment @

{
"as7Domain™: "AS7 DOMAIN MAME",
"authUsername™: "CRM_UN",
"authPassword”: "CRM_PW"

3}

Sub Environments

L8 R W R
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CONFIGURE THE FIRST GET REQUEST AS TEMPLATE

» Configure the first request as template o e
and apply the values of the basic
environment variables. e

» Later duplicate this template for further requests and you
have all done for the interaction with the anSwitch V7.

Body = Auth =

a. Configure the GET request URL

> Configure the request:
» Select the request type: GET

» Start with the Url: https://

GET + https//I R el U d /rest/orgUnits

Body + Query Headers 1 Docs

cer . New Request API Key Auth
Basic Auth @ ]
Digest Auth

@ Base Environmen t v - GET v https:/JEEENGTRI S ESy BN WU /rest/orgUnits

@ Add Cookies

» Insert the domain name from the environment variable:
Crtl + Space - Select"_.as7Domain"

Filter AUTH TYPES

» Continue the path and REST object, e.g.: /rest/orgUnits

b. Configure the authentication.

» Use the environment variables

> Select tab "Auth" :
» Select: Basic Auth

Body ¥ Basic v Query Headers Docs

Filter s ©
ENABLED

» Insert the authentication values from the environment
variables:
Crtl + Space - Select"_.authUsername", "_.authPassword" S

USE I1SO 8859-1@ a

mNE
D
5
g |8
g X
8 3
9 1)
s % 2
2 S NG
[=
g 2 g
-
2
i
3
2
[¥)
.y
ue}
3
4

GET  TEMPLATE GET Request
USERNAME

> Fire your first request - click button: Send
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CONFIGURE THE FIRST POST REQUEST AS TEMPLATE

» Configure a POST request as template. o e o R =

@ Add Cookies Body ¥ Basic v Query Headers ! D|

Filter : O

a. Make a copy of the GET request | o [ -

femplate —7 @ poee
> At 'TEMPLATE GET Request"; mp— BN vy

. |
» Select: Duplicate
> Rename the request: TEMPLATE POST Request

@ Base Fpui POST v https://BEEER G s S-Sy e N Yl / rest/orgUnitAttributes

@ Add Cookies

EET Basic v Headers 1 Docs
. Filter POST
b. Configure the POST request URL
AE {Base Environment}: CRM UN
> Configure the request: T o e

DELETE

@ Base Environment v -] POST = https:///rest/orgUnitAttributes

@ Add Cookies

» Select the request type: POST

» Continue the path and REST object to be created, e.g.:
/rest/orgUnitAttributes

Basic ¥ Query Headers ! Docs
Filter Presentation last modified: 55m ago

6T | TEMPLA Multipart Form

c. Configure the body of the POST.

> Select tab "Body" : p—

» Select: JSON Enter a URL and send to get a response

» Insert the body contents in JSON notation, e.g.:

TEMPLATE  Form URL Encoded

GraphQL Query

NN LN

® sase Enironment = o PoST = hitpsy/ TR PR -t crgUnitAtributes

{ " " " . m @ Add Cookies
name": "dummyAttribute",

"value": "blabla",
"orgUnitId": 1
} GET | TEMPLATE GET Request

JSON = Basic ¥ Query Headers 2 Docs

|

{
"name": "dummyAttribute”,
“value": "blabla",
“orgUnitId™: 1

}

ubh wnNn PR

[V IR

| posT - TEMPLATE POST Request




9  EXAMPLE: CREATE
PBX & PBX
EXTENSION



Y4 EXAMPLE: CREATE PBX & PBX EXTENSION OOAST)

EXAMPLE OVERVIEW: CREATE PBX & PBX EXTENSION

» Goal: Tenant "Provider A"
» Create a basic PBX and its PBX Extensions.
PBX "PBX REST Test"
» Datato prepare: PBX Extensions: PBX Public Numbers: _@
) . . . Range: 0445555300-9
» Values used in the example, see picture on the right side. SBX Exfonsion- 301 User O PSTN
[0 Have ready the OrgUnit ID of the parent Tenant. User :Ci':)stﬁ?; serone
[0 Unique PBX Name » User One < Direct Dialing In 40445555301
[0 Description of the PBX » userl@test.com — Displayed Nmb — 0445555305
» English
[0 Hidden TopStop
O Value, note/block, email addresses
[0  Public numbers and number ranges
[0  User account for the PBX Administrator
O Email address, first & last name, language
[0 PBX Extensions & internal Number & DDI
O Private number, display name, DDI, displayed public number
[0 User account for the PBX Member Hidden TopStop:
O Email address, first & last name, language Note:
» Level: 80%
> ASSUFﬂpTiOﬂSZ PBX Administrator: » noc@test.com
» John Must Block:
» Inherited from any parent OrgUnit N jrﬁ@rﬁes;’éoer; O,Cvmue; 50
» CTl basic configuration » English » noc@test.com
» PBX pricelists
» PBX limits, e.g. extension types, channels
» Access to the PSTN via the system default routes and

gateways. PBX Administrator
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EXAMPLE OVERVIEW: CREATE PBX & PBX EXTENSION

» Overview of the execution steps:
Create PBX "PBX REST Test".

1.

a.
b.
C.

GET: Get OrgUnit ID of Tenant "Provider A"
GET: Check if new PBX name "PBX REST Test" is already used
POST: Create PBX "PBX REST Test"

Create PBX Administrator.

(o}
p.
C.

GET: Check if a user with email "im@rest.com" already exists.
POST: Create user account of "jm@rest.com"
POST: Assign role "PBX Administrator" o user jm@rest.com

Assign PBX public numbers, limits, etfc.

a0 o0

Create PBX extension with internal number, user

GET: Check if an address with number "0445555300" already exists.
POST: Create the public numbers "0445555300-9".

GET: Get data of all public numbers of the PBX.

POST: Create the PBX limitations, e.g. channel limits.

account and DDI.

®a00Q

POST: Create PBX Extension of "User One".

POST: Create user "User One".

POST: Assign the user role.

POST: Assign the private number 301.

POST: Assign DDI & displayed public number for 301.

Create hidden TopStop.

(o}
p.

POST: Create the TopStop biling account for the PBX.
POST: Assign the TopStop limit conditfions.

» Overview of involved DB objects

a

OrgUnit
name: Provider A
type: tenant

$

User
email: jm@rest.com

:

UserRole
role: pbx

00 ©©

OrgUnit

id: 519

name: PBX REST Test
type: pbx

User
email: userl@rest.com

OrgUnitAttribute
name:
value: 10

maxExtensions

Address

number: 0445555300

BillingAccount
hidden: true

value

BillinglLimit

:

10.0

Forward
type: cfu

destination: 301

i

glele

UserRole
role: extension

Orgunit
id: 523
name: User One
type: extension

Address
4—@ number: 301
name: User One

OO0 ®O OO
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EXAMPLE CODE: CREATE PBX
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1. Create PBX "PBX REST Test"
a. GET: Get OrgUnit ID of Tenant "Provider A"

GET https://DOMAIN_REST/rest/orgUnitsorgUnitsewhere=name.like ('Provider
A')&properties=id

No body

b. GET: Check if new PBX name "PBX REST Test" is already used.

GET https://DOMAIN_REST/rest/orgUnitsorgUnits2where=name.like ('PBX REST
Test') &properties=id

No body

c. POST: Create OrgUnit ID of PBX "PBX REST Test"

POST https://DOMAIN_REST/rest/orgUnits

{
"name" : "PBX REST Test",

"type" : "pbx",
"descriptfion": "PBX of company REST",
"parentld" : 25

€ Mandatory value

a.

C.

Response

200 OK

{
"orgUnits": [
{
"id" 25
P}

€ OrgUnit ID of the tenant, save for later use!

Response

200 OK

"orgUnits": []
}

The expected result is "empty".
If not, then a PBX with this name exists.

Response

200 OK

{

|||||

|||||

€ OrgUnit ID of the PBX, save for later usel
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net?
2. Create PBX Administrator
a. GET: Check if a user with email "j/m@rest.com" already exists. a. Response
GET 200 OK
https://DOMAIN_REST/rest/usersewhere=email like (jm@rest.com’)&properties=id { The expected result is "empty’.
No body ‘ "orgUnits": [] If not, then a user with this email exists.
}
{ If there is an ID, then check if this user really is the
"orgUnits": [ expected user. If yes, then go directly to 2.c)
{
"id": I € User ID of the PBX administrator to be, save for later
11} use!
b. POST: Create user account of "jm@rest.com” b. Response
POST https://DOMAIN_REST/rest/users 200 OK
{ {
"firstName" : "John", "name": null,
"lastName" : "Muster", € Set no password, this the user shall do on id": -

€ Remember the user ID for assigning the role.
"email" : "jm@rest.com”, his first login.

"language” : "en",
"orgUnitld" : "519"

"language": "en",
"password": null,

"pin": null,

"orgUnitld": "519",
"email": "jm@rest.com”,
"pinFails™: O,
"pinBlocked": O,
"passwordFails": 0,
"passwordBlocked": 0,
“firstName": "John",
"lastName": "John",
"sendEmailVoicemail”; false



https://domain_rest/rest/orgUnits/2
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EXAMPLE CODE: CREATE PBX ADMINISTRATOR

2. Create PBX Administrator

c. POST: Assign role "PBX Administrator" to user jm@rest.com. Cc. Response
POST https://DOMAIN_REST/rest/userRoles 200 OK
{ {
"userld" : "1, "userld":"111",
"role" : "pbx", € Mandatory value! "role": "pbx",
"orgUnitld": "519" "orgUnitld": "519"
} }
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EXAMPLE CODE: ASSIGN PBX PUBLIC NUMBERS, LIMITS, ETC.

3. Assign PBX public numbers, limits, etc.

a. GET: Check if an address with number "0445555300" already a. Response
exists.
GET https://DOMAIN_REST/rest/addressesewhere=number.like ('0445555300') 200 OK
&properties=id The expected result is "empty".
No body "addresses": [] If not, then a number with this number exists.
}
{ If there is an ID, then check if this address really is
"addresses": [ assigned fo this PBX.
"id": 720
}1}
b. POST: Create public number of " 0445555300 ". pb. Response
» 3.b) must be done for every single public number!
» Make sure always to use the same epoch for "validFrom".
Even when you later add additional public numbers.
POST https://DOMAIN_REST/rest/addresses 200 OK

{ {

"name": null,

}

"orgUnitld": 519,
"validFrom": 1699875180000

€ Insert the epoch of the real date/time.

C.

GET: Get data of all public numbers of the PBX.

GET https://DOMAIN_REST/rest/addressesewhere=orgUnitld. eq(519)

No body

"id": 728,
"orgUnitld": 519,

"walidFrom': 1699875180000,

"validuntil": 9223372036854775807,

€ Remember the address ID for:
» Assigning the DDI
» Deleting the number
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EXAMPLE CODE: ASSIGN PBX PUBLIC NUMBERS, LIMITS, ETC.
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3. Assign PBX public numbers, limits, etc.

» Several PBX parameters are configured as OrgUnit attributes,
e.g. atftributes with name:

» maxExtension » fimezone
» maxServiceExtension » dateformat
» maxExternalChannels » fimeformat

d. GET: Check the existence of a PBX OrgUnit attribute.

» Process configuring an OrgUnit attribute:
1. Check if the OrgUnit attribute for the PBX already exists.
2. Depending on the result apply a POST for creating the attribute or
a PUT for changing the attribute value.

d. Response

GET

https://DOMAIN_REST/rest/orgUnitAttributesewhere=name.like (‘'maxExtensions').a
nd(orgUnitld.eq(519))

No body

e. POST: Create a PBX OrgUnit attribute.

200 OK

"orgUnitAttributes" []
}

The OrgUnit atfribute doesn't exist yet.
- Do 3.e) for creating the attribute.

{II

walue'™: 5",
"id": 746,
"orgUnitld": 519

}

The OrgUnit attribute exists.
- Do 3.f) for changing the value of the attribute.

e. Response

POST https://DOMAIN_REST/rest/orgUnitAttributes

200 OK

{

"value'": 5,
"orgUnitld": 519

}

f.  PUT: Change a PBX OrgUnit attribute value.

{
value'™: 5",
"id": 746,
"orgUnitld™: 519

}

If there is an ID, then check if this address really is
assigned fo this PBX.

d. Response

PUT https://DOMAIN_REST/rest/orgUnitAttributes/746

200 OK

"value": 10

}

Check the modified OrgUnit attribute data with a
GET .../orgUnitAttributes/746
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EXAMPLE CODE: PBX EXTENSION, INTERNAL NUMBER, DDI

4. Create PBX extension with internal number, user » Process configuring an OrgUnit attribute:

account and DDI. 1. Creatfe the PBX Extension

. e 2. Assign the user account.
|
» Every PBX Extension must be created individually! 3. Assign the private number.

a. POST: Create PBX Extension of "User One" a. Response
POST https://DOMAIN_REST/rest/orgUnits 200 OK
{ {
"name" : "User One", "name": "User One", € Remember the extension name for the phone
"type" : "extension’, € Mandatory value configuration.
"parentld": 519 "id": 528, € Remember OrgUnit ID of the PBX Extension for:
} "type": "extension’, » User account androle
"description": null,
"parentld": 519
}
b. POST: Create user account "User One" b. Response
POST https://DOMAIN_REST/rest/users 200 OK
{ {
"firstName" : "User", "name": null,
"lastName" : "One", "id": 113, € Remember the user ID for :
"email" : "user1@rest.com", » The userrole
"password": "secret”, € Set a password | » Private number
"language" : "en", This enables us to activate the auto "language": "en", » Terminal
"orgUnitld" : - provisioning of the phone types "password": "crypt:XEH7Z17g33VmOw==", & Note: The password is encrypted!
} anDesktop and anConnect. "orgUnitld": b
"pin": null,
"email"; "userl@rest.com’,
"pinFails": O,
"pinBlocked": 0,

"passwordFails": 0,
"passwordBlocked": O,
"firstName": "User",
"lastName": "One",
"sendEmailVoicemail": false
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EXAMPLE CODE: PBX EXTENSION, INTERNAL NUMBER, DDI

4. Create PBX extension with internal number, user
account and DDI.

c. POST: Assign role "PBX Administrator" to user user1 @rest.com Cc. Response
POST https://DOMAIN_REST/rest/userRoles 200 OK
{
"userld” : "G, "id": 235,
"role" : "extension’, € Mandatory value! "orgUnitld": 523,
"orgUnitld" : "523" "userld™: 113,
} "role"; "extension”
}
d. POST: Assign the private number 301 d. Response
POST https://DOMAIN_REST/rest/addresses 200 OK
{ {
"number": "301", "name"; "User One",
"name": "User One" < Name to display. "id™: - € Remember the address ID for:
"orgUnitld": 523, & OrgUnit ID of the new PBX Extension "number": "301", » Assigning the location of an associated terminal
"userld" - "orgUnitld": 523, » Obtaining the list of VoiceMail messages
"scopeOuld": "519" < scopeOuld: OrgUnit ID of the PBX or a "userld™: 113,
} Department of this PBX.
e. "scopeOuld": 519,
}
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EXAMPLE: CREATE PBX & PBX EXTENSION

EXAMPLE CODE: PBX EXTENSION, INTERNAL NUMBER, DDI

aare
net)

4. Create PBX extension with internal number, user
account and DDI.

e. POST: Assign DDI to 301.
» DDlis just an ordinary call forwarding unconditional CFU.

POST https://DOMAIN_REST/rest/forwards

"addressld": 729,

"destination": 301,
" "cfu" € Mandatory value.

PUT: Assign displayed public number 0445555305 to 301.

PUT https://DOMAIN_REST/rest/addresses/743

{
"publicAddrid": 733 < Address ID of public number 0445555305
}

e.

Response

200 OK

{
id": 664,

"delay": 0,
"fimetableld": O,
"addressld": 729,
"inactive": false,
"timePattern": null

€ Remember the address ID for:
» Assigning the DDI
» Deleting the number

Response

200 OK

{

"name": "User One",
||id||: -’

"number";: "301",
"orgUnitld": 523,
"userld™: 113,

"oublicAddrid"; 733
"';copeOuId": 519,

Check the modified address data with a
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EXAMPLE CODE: CREATE HIDDEN PBX TOPSTOP

5. Create hidden PBX TopStop.

a. POST: Assign note and block conditions.

a. POST: Create the TopStop billing account for the PBX. a. Response

POST https://DOMAIN_REST/rest/bilingAccounts 200 OK
{ {
"orgUnitld": 519, < PBX OrgUnit ID "value": 0.0,
"type": "charge", € Mandatory value. "id": 48, € Remember the billing account ID for:
“resetTime™: 1701385200000, < Insert the current epoch date/time "type": "charge”, » Assigning note and block level
"resetMonthly": frue, "hidden": true,
"hidden": frue, "units": null,
"flags": 18 € Mandatory value. "resetDaily": false,
} "resetMonthly": tfrue,
"resetTime": 1701385200000,
"orgUnitld": 519
}
GET: The date of the billing account. Response
GET https://DOMAIN_REST/rest/bilingAccounts/48 200 OK
{
"value": 0.0,
"id": 48,
"type": "charge”,
"hidden": true,
"units": null,

"resetDaily": false,
"resetMonthly": true,
"resetTime": 1701385200000,
"orgUnitld": 519
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EXAMPLE: CREATE PBX & PBX EXTENSION

EXAMPLE CODE: CREATE HIDDEN PBX TOPSTOP
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5. Create hidden PBX TopStop.

a. POST: Create the TopStop billing account for the PBX.

POST https://DOMAIN_REST/rest/bilingAccounts

"orgUnitld": 519,

"type": "charge”,
"resetTime": 1701385200000,
‘resetMonthly": frue,
"hidden": frue,

"flags": 18

< PBX OrgUnit ID
€ Mandatory value.
< Insert the current epoch date/fime

€ Mandatory value.

b. POST: Assign the TopStop limit conditions.

< For a blocking limit set the value to frue.

POST https://DOMAIN_REST/rest/billingLimits
{

"value": 10.0,

"enabled": frue,

"blocking": false,

"bilingAccountld": 48,

"notifyMail"; "noc@rest.com"
}

a.

b.

Response

200 OK

{

"value": 0.0,

"id"; 48,

"type": "charge”,
"hidden": true,
"units": null,
"resetDaily": false,
"resetMonthly": true,

"resetTime": 1701385200000,

"orgUnitld": 519

€ Remember the billing account ID for:
» Assigning note and block limits

< Take the currency type from the assigned pricelist.

Response

200 OK

{

"value": 10.0,

"id"; 40,

"enabled": frue,
"blocking": false,
"disabled": false,
"bilingAccountld"; 48,

"notifyMail": "noc@rest.com”,

"notifyTime™: 0

€ Remember the billing limit ID for:
» Adjusting the value
» Adjusting the email address
» Blocking/de-blocking the limit
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EXAMPLE OVERVIEW: ASSIGN & PROVISION PHONES

» Goal: ~ |- Tenant "Provider A"

» Assign different phone types to a PBX Extension. O g - )
7 ¥ 7P o ki PBX "PBX REST Test
» Datato prepare: Auto-Provisioning PBX Extensions: PBX Public Numbers: _@
) . . . Range: 0445555300-9
» Values used in the example, see picture on the right side. PSTN
[0 Have ready the type of phone. _ PBX Extension:
[J Phone Name Name: "Mobile — an IP Phone" 1301 <— DDl
[0  For 39 party SIP-Phone provisioning have ready: Type: an IP-Phone Name: User One
O For the device configuration interface, e.g. Web Auto-Provisioning N
administration. Usef‘l. .
[0 Username for admin and eventually user 7 || | [emall: useri@rest.con
—
= Possworq. . Name: "Meet - anConnect"
[0  For auto-provisioning the MAC address of the phone Type: anConnect
device. Auto-Provisioning
O
4 Assump’rions: Name: "Home Office — Type bc"
»  On the anSwitch V7 system level the phone Type: 3':5%’%;'5{;;3:9
manufacturer redirection service is configured. MAC: 1 ]:22:33:44:55:6%
» On the system, tenant or PBX level the basic CTI URL is
configured. _
» Onthe tenant or PBX level an optional other name for ‘ ‘ o
the anDesktop is configured. Name: "Vacation Office — Type xyz"

Type: 3'd Party SIP-Phone

» The PBX Extension has assigned a user account. URL-Provisioning
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EXAMPLE OVERVIEW: ASSIGN & PROVISION PHONES

» Overview of the execution steps: » Overview of involved DB objects
1. Assign a phone type to an address. p——

» For each phone type that is assigned to a PBX Extension nafe: PBX REST Test
an own terminal must be created. type: pbx
For each terminal, an own location must be created. I
For each terminal type different types of terminal Jser Orgunit
attributes must be created. id: 113 +—> e

> Exomples for: email: userl@rest.com type: Bxtension
» Terminal type: anDesktop
» Terminal type: an IP-Phone
» Terminal type: anConnect
» Terminal type: 3@ Party SIP-Phone, Auto-Provisioning Virrece
» Terminal type: 3@ Party SIP-Phone, URL-Provisioning id: 743

number: 301
name: User One

a. POST: Create the terminal and its needed terminal attributes.
b. POST: Create the terminal location.
C. POST: Create message subscriptions.

Terminal
id: 455
name: Home Office
type: yealinkT40G

\

TerminalAttribute
name: provisionOpt
value: autoprov

TerminalAttribute -‘

Location
terminalld: #58
addressId :

2. Provision the phone.

a. PUT: Make ready the provisioning the phone.
b. PUT: Send an email to the user with installation instructions.

Subscription
event-type: message-summary

name: mac
value: 11:22:33:44:55:66




TERMINAL TYPE
"ANDESKTOP”"
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EXAMPLE: CREATE PBX & PBX EXTENSION

EXAMPLE CODE: TERMINAL TYPE "ANDESKTOP"

aare
net)

1.

Assign a phone type "anDesktop" to an address.

a. POST: Create the terminal.

POST https://DOMAIN_REST/rest/terminals

{

"name" : "Office - anDesktop",

"type” : ",

"orgUnitld" : 523,

"userld": 113,

"password": "fsdfgsdfgf98ug00hzHJBS",

"username": "453lkinMN43"
}

€ Mandatory value
< OrgUnit ID of the PBX Extension.

< Always create a new random password
< Always create a new random username

GET: Check the terminal data

GET https://DOMAIN_REST/rest/terminals/B8#

variant:

GET hittps://DOMAIN REST/rest/terminalse=&where=name.like ('Office -

anDesktop')

a.

Response

200 OK

{

"name"; "Office - anDesktop",
g -,

"type": "cti",
"password":

"crypt:0OxsnNa_fTXgmO20jjyNXKKFOgR",

"username": "453lkjnMN43",
"barred": false,

"orgUnitld": 523,

"userld™: 113,
"emergencylLocationid": O,
"sendAoc": false,
"sendsMusicOnHold": false,
"specialArangement": false,
"gateway": false,

"noGui": false,
"markedDelete": false

€ Remember the terminal ID for:
» Terminal attributes
» Location
» Subscription



https://domain_rest/rest/terminals/455
https://domain_rest/rest/terminals/455
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EXAMPLE CODE: TERMINAL TYPE "ANDESKTOP"

1. Assign a phone type "anDesktop" to an address.

a. POST: Create the needed terminal attributes
»  Mandatory terminal attributes for this ferminal type:

POST https://DOMAIN_REST/rest/terminal Attributes
{

"terminalld": B8,
"name"; "provisionOpt",
"value": "anDesktop” € Mandatory value

"terminalld": B8,

"value": CIroNZRvX4Q9QUzulffy339db124 € Any random sfring

GET: Check all terminal attributes of this terminal
GET https://DOMAIN REST/resT/TerminoIAHribuTes?=&where=ferminoIId.eq(-)

b. POST: Create the terminal location.

POST https://DOMAIN_REST/rest/locations 200 OK
{
"terminalld"; 284,
"addressld": 743 "id": 289,
} "terminalld": 297,

"addressld": 743,



https://domain_rest/rest/terminals/455

85

EXAMPLE: ASSIGN & PROVISION PHONES

EXAMPLE CODE: TERMINAL TYPE "ANDESKTOP"

adre

net)

2.

Provision the phone.

a. PUT: Make ready the provisioning the phone.

PUT https://DOMAIN_REST/rest/terminals/297 .provision

{ & The body must be empty!

b. PUT: Send an email fo the user with installation instructions.

C.

Response

200 OK

{
"provisioningOption": "anDesktop”,
"status": 200,
"ctiDevicelD": "term.297",
"windowsDownloadURL": "https://IP-ADDR/cti/app/update/belasAnDesktop-latest.exe”,
"macOSDownloadURL": "https://IP-ADDR/cti/app/update/belasAnDesktop-latest.pkg",
"setupURL": "nttps://IP-ADDR/cti/app/redirect/ancall2data=ancall%3Asetup%...."

PUT https://DOMAIN_REST/rest/terminals/297.mail

200 OK

{ & The body must be empty!

No body




TERMINAL TYPE
"AN |IP-PHONE"
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EXAMPLE: CREATE PBX & PBX EXTENSION

EXAMPLE CODE: TERMINAL TYPE "AN IP-PHONE"

aare
net)

1.

Assign a phone type "an IP-Phone" to an address.

a. POST: Create the terminal.

POST https://DOMAIN_REST/rest/terminals

{

"name" : "Mobile — an IP-Phone",
"type" : "anlpPhone’,

"orgUnitld" : 523,

"userld": 113,

"password"; "fsdfgsdfgf98ug00hzHJBS",

"username”: "fvg56AS056"
}

€ Mandatory value
< OrgUnit ID of the PBX Extension.

< Always create a new random password
< Always create a new random username

GET: Check the terminal data

variant:
GET https://DOMAIN_REST/rest/terminalse
Phone')

GET https://DOMAIN_REST/rest/terminals/299

=&where=name.like ('‘Mobile — an IP-

a.

Response

200 OK

{

"name": "Mobile — an IP-Phone",
||id||: -,

"type": "anlpPhone",

"password":  "crypt:OxsnNa_fTXgmO20jjyN",

"username": "fvg56AS056",
"barred": false,

"orgUnitld": 523,

"userld": 113,
"emergencylLocationid": O,
"sendAoc": false,
"sendsMusicOnHold": false,
"specialArangement: false,
"gateway": false,

"noGui": false,
"markedDelete": false

€ Remember the terminal ID for:
» Terminal attributes
» Location
» Subscription
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EXAMPLE CODE: TERMINAL TYPE "AN IP-PHONE"

1. Assign a phone type "an IP-Phone" to an address.

a. POST: Create the needed terminal attributes
»  Mandatory terminal attributes for this ferminal type:

POST https://DOMAIN_REST/rest/terminal Attributes
{

"terminalld": §08,
"name"; "provisionOpt",
"value": "anipphone” € Mandatory value

"terminalld": §08,

"value": "2970b73605911789" < Any random string

GET: Check data of all terminal attributes of this terminal
GET https://DOMAIN_REST/rest/terminalAttributes2=&where=terminalld.eq (288)

b. POST: Create the terminal location. b. Response
POST https://DOMAIN_REST/rest/locations 200 OK
{
"terminalld": B08,
"addressld": 743 "id": 300,
} "terminalld": 308,
"addressld": 743,
}
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EXAMPLE CODE: TERMINAL TYPE "AN IP-PHONE"

1. Assign a phone type "an IP-Phone" to an address.

c. POST: Create message subscriptions "message-summary'. Cc. Response

POST https://DOMAIN_REST/rest/subscriptions 200 OK

{ {
"terminalld"; 588, "id": 928,
"eventType": "message-summary’, € Mandatory value "eventType": "message-summary”,
"notifierld": "743", < Terminal ID "terminalld™: 455,
"notifierNumber": "301", < Privat phone number "nofifierld": "743",
"subscriberAddrld": 743, < Terminal ID "notifierNumber"; "301",
"subscriberNumber": "301" < Privat phone number "subscriberAddrld": 743,

} "subscriberNumber": "301",

POST: Create message subscriptions "as-feature-event".

POST https://DOMAIN_REST/rest/subscriptions

{
"terminalld"; 588,
"eventType": "as-feature-event”,
"notifierld": "743",
"notifierNumber": "301",
"subscriberAddrid"; 743,

"subscriberNumber": "301"

€ Mandatory value

< Terminal ID

< Privat phone number
< Terminal ID

< Privat phone number

GET: Check data of all subscriptions of this terminal

GET h’r’rps://DOMAIN_REST/res’r/subscrip’rions?=&where=’rermino|ld.eq(-)

200 OK

{
"id": 926,

"eventType": "message-summary",

"terminalld"; 455,
"notifierld": "743",
"notifierNumber": "301",
"subscriberAddrid": 743,
"subscriberNumber": "301",
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EXAMPLE: ASSIGN & PROVISION PHONES

EXAMPLE CODE: TERMINAL TYPE "AN IP-PHONE"
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2. Provision the phone.

a. PUT: Make ready the provisioning the phone.

PUT https://DOMAIN_REST/rest/terminals/308.provision

{ & The body must be empty!

b. PUT: Send an email fo the user with installation instructions.

Response

200 OK

{
"provisioningOption": "an IP-Phone”,
"status": 200,

"accountlD": "otc@CLID_ASV7",
"password"; "2970-b736-a591-1789"

}

"link™: "csc:otc:2970b736a5911789@CLID_AS7POC2*",

PUT https://DOMAIN_REST/rest/terminals/308.mail

200 OK

{ & The body must be empty!

No body




TERMINAL TYPE
"ANCONNECT
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EXAMPLE: CREATE PBX & PBX EXTENSION

EXAMPLE CODE: TERMINAL TYPE "ANCONNECT'
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1.

Assign a phone type "anConnect" to an address.

a. POST: Create the terminal.

POST https://DOMAIN_REST/rest/terminals

{

"name” : "Meet — anConnect",
"type" : "anConnect’,
"orgUnifld" : 523,

"userld": 113,

"password"; "rtzeZIlUZ7843sdfKL",

"username": "gK4dg89345mwilP"

€ Mandatory value
< OrgUnit ID of the PBX Extension.

< Always create a new random password
< Always create a new random username

GET: Check the terminal data

variant:
GET https://DOMAIN _REST/rest/terminalse
anConnect’)

GET https://DOMAIN_REST/rest/terminals/Sil8

=&where=name.like (Meet —

a.

Response

200 OK

{

"name"; "Meet — anConnect",
||id||: -,

"type": "anConnect",

"password":  "crypt:OxsnNa_fTXgmO20jjyN",

"username": "gK4dg89345mwlP",
"barred": false,

"orgUnitld": 523,

"userld": 113,
"emergencylLocationid": O,
"sendAoc": false,
"sendsMusicOnHold": false,
"specialArangement": false,
"gateway": false,

"noGui": false,
"markedDelete": false

€ Remember the terminal ID for:
» Terminal attributes
» Location
» Subscription



https://domain_rest/rest/terminals/455
https://domain_rest/rest/terminals/455
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EXAMPLE CODE: TERMINAL TYPE "ANCONNECT'

1. Assign a phone type "anConnect" to an address.

a. POST: Create the needed terminal attributes

» None
b. POST: Create the terminal location. b. Response
POST https://DOMAIN_REST/rest/locations 200 OK
{
"terminalld": -
"addressid": 743 "id": 302,
} “terminalld": 309,
"addressld"; 743,
}
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EXAMPLE CODE: TERMINAL TYPE "ANCONNECT'

1. Assign a phone type "anConnect" to an address.

c. POST: Create message subscription "dialog”. Cc. Response

POST https://DOMAIN_REST/rest/subscriptions 200 OK

{ {
"terminalld": 518, "id" 931,
"eventType": "dialog", € Mandatory value "eventType": "dialog",
"notifierld": "743", < Terminal ID "terminalld™: 455,
"notifierNumber": "301", < Privat phone number "nofifierld": "743",
"subscriberAddrld": 743, < Terminal ID "notifierNumber"; "301",
"subscriberNumber": "301" < Privat phone number "subscriberAddrld": 743,

} "subscriberNumber": "301",

}

GET: Check data of all subscriptions of this terminal
GET https://DOMAIN_REST/rest/subscriptionsg2=&where=terminalld.eq (828) 200 OK
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EXAMPLE CODE: TERMINAL TYPE "ANCONNECT'

1. Assign a phone type "anConnect" to an address.

c. PUT: Make ready the provisioning the phone. Cc. Response
PUT https://DOMAIN_REST/rest/terminals/310 200 OK
{ {
"type": "anConnect" = Mandatory value
} }

PUT https://DOMAIN_REST/rest/terminals/310.provision

{ Not available yet!
< The body must be empty!

d. PUT: Send an email to the user with installation instructions.
PUT https://DOMAIN_REST/rest/terminals/310.mail 200 OK
{} < The body must be empty! No body




TERMINAL TYPE
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net)
EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
AUTO-PROVISIONING"

»  Provisioning a "3 Party SIP-Phone" via the REST APl can be o
tedious work, as every manufacturer has different parameters
that need to be configured.

» The type of parameters may also differ from phone type to phone type of the same manufacturer.
» The different parameters are represented in the "Terminal Attributes'.

» The following instructions are just a guideline.

1. Provision only 3@ party SIP-phone types that can be provisioned via the Portal Ul
- You can evaluate all needed terminal attributes and their values.

2. Assign via the Portal Ul the desired phone type and read out all generated Terminal Attributes.
a) Give this phone a unigue name that you can search via the REST API, e.g.: "test phone xyz".
b) Get the terminal ID and type of the phone "test phone xyz"

GET https://DOMAIN_REST/rest/terminals2=&where=name.like('test phone xyz')&properties=id,type

c) Get all terminal attributes that were generated for the phone "test phone ab"
GET https://DOMAIN_REST/rest/terminal Attributes2=&where=terminalld.eq(320)

d) Use the parameter "type" and all listed terminal attributes for your provisioning.
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EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
AUTO-PROVISIONING"

» For this REST APl example a Yealink T40 G is chosen.

» Assign a phone Yealink T40 G with name "test phone
Yealink T40G" to a PBX Extension the REST APl has
access rights fo.

a. GET: Get the terminal type and ID of this test phone. a. Response
GET https://DOMAIN_REST/rest/terminalse=&where=name.like (test phone Yealink 200 OK
T40G') & properties=id,type {
"terminals"; |
{
"id": 320,
"type": "yealinkT40G" € Remember this type for:
11} » The phone type creation via REST API.
b. GET: Get the terminal attributes of this test phones b.  Response
GET hitps://DOMAIN_REST/rest/terminalAttributes2=8&where=terminalld.eq(320) 200 OK
{ The whole list of terminal attributes are returned
"terminalAttributes™: ... for this Yealink T40G with auto-provisioning.

Example: Yealink T40G |Termin0| Attribute Name |Vo|ue |Remork

Mandatory terminal attributes for provisionOpt ‘autoprov” Provisioning type

Auto-Provisioning macAuth "frue” Mandatory due to the provisioning type

mac "11:22:33:44:55:66" MAC address of the device
Terminal attributes needed for the webAdminname "admin” Admin username
correct working of this phone type. webAdminPassword "crypt:ejHpabqU7" Encrypted admin password
webUsername "user” User username
Note: fkey1 "line/743//301 User One" Atftributes with instructions for configuring
The names and values can change attrDisplayFirstPageOnly "false" the first configurable function key of the

according the selected phone type. attrPhoneFirstPageOnly "false" phone.
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EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
AUTO-PROVISIONING"

1. Assign a phone type "3rd Party SIP-Phone, Auto-
Provisioning" to an address.

a. POST: Create the terminal Yealink T40G. a. Response

POST https://DOMAIN_REST/rest/terminals 200 OK

{ {
"name” : "Home Office — Yealink T40G", "name": "Home Office — Yealink T40G",
"type" : "yealinkT40G", € Mandatory value "id": B2, € Remember the terminal ID for:
"orgUnitld" : 523, < OrgUnit ID of the PBX Extension. "type": "yealinkT40G", » Terminal attributes
"userld": 113, "password": "crypt.ejlHpabgU7PPcvigAob_Jt", » Location
"password"; "fsdfgsdfgf45rvbug00hzHJBS", < Always create a new random password "username": "abh56AS056", » Subscription
"username; "abh56AS056" < Always create a new random username "barred": false,

} "orgUnitld": 523,

"userld": 113,

"emergencylLocationld": O,
"sendAoc": false,
"sendsMusicOnHold": false,
"specialArangement”: false,
"gateway": false,

"noGui": false,
"markedDelete": false

b. GET: Check terminal data

GET https://DOMAIN_REST/rest/terminals/821

variant:

GET https://DOMAIN_REST/rest/terminals¢=&where=name.like (Home Office —
Yealink T40G')
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EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
AUTO-PROVISIONING"

1. Assign a phone type "3rd Party SIP-Phone, Auto- b. POST: Create the terminal aftributes for the correct working of this

Provisioning" to an address. phone type
POST https://DOMAIN_REST/rest/terminalAttributes
b. POST: Create the mandatory terminal attributes for auto- { )
S "terminalld": -,
provisioning. "name": "webAdminname",
POST https://DOMAIN_REST/rest/terminal Attributes : ‘value': "admin” € Mandatory value!
{
"terminalld": B2, { ., ) .,
"name'": "provisionOpt", “terminalld : 828, ) 5
"value": "autoprov" € Mandatory valuel name": "‘webAdminPassword",
} "value": "'mySecretPw" < Insert a secure password!
; }
"terminalld": - { .
"name"™: “macAu,th", ::Termlqlcllld": 325, )
"value': "true" < Mandatory value! ‘name": "webUsername”,
} value': "user < Mandatory value!
{ }
"terminalld": R {
"name": “mqy "terminalld: 828,
"value'; "66:55:44:33:22:11" € Insert the MAC address of the device ‘name”: "fkey1",
} "value™ "Iine/743//- _ € The value composes:
} "line/<ADDRESS_ID>//<PRIVATELNUMBER®
<EXTENSION NAME
{
"terminalld”: §28,
"name"; "attrDisplayFirstPageOnly",
"value": "false”
}
GET: Check data of all terminal attributes of this terminal. {
"terminalld”: 828,
GET ths://DOMAIN_REST/resT/TerminoIAT‘rribu‘res?=&where=fermino|ld.eq(-) "name": "attrPhoneFirstPageOnly",
value": "false"
}
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EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
AUTO-PROVISIONING"

1. Assign a phone type "3rd Party SIP-Phone, Auto-
Provisioning" to an address.

c. POST: Create the terminal location. C. Response
POST https://DOMAIN_REST/rest/locations 200 OK
{
"terminalld": B2,
"addressid": 743 "id": 314,
} "terminalld": 321,
"addressld": 743,
}
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EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
AUTO-PROVISIONING"

1. Assign a phone type "3rd Party SIP-Phone, Auto-
Provisioning" to an address.

d. POST: Create message subscriptions "message-summary'. d. Response

POST https://DOMAIN_REST/rest/subscriptions 200 OK

{ {
"terminalld": - "id": 944,
"eventType": "message-summary’, € Mandatory value "eventType": "message-summary",
"nofifierld": "743", & Terminal ID "terminalld": 321,
"noftifierNumber": "301", < Privat phone number "nofifierld": "743",
"subscriberAddrlid": 743, & Terminal ID "notifierNumber": "301",
"subscriberNumber": "301" < Privat phone number "subscriberAddrid": 743,

} "subscriberNumber"; "301",

}
POST: Create message subscriptions "as-feature-event".

POST https://DOMAIN_REST/rest/subscriptions 200 OK

{ {
"terminalld": B2, "id": 945,
"eventType": "as-feature-event”, € Mandatory value "eventType": "message-summary",
"notifierld": "743", < Terminal ID "terminalld™: 321,
"notifierNumber": "301", < Privat phone number "notifierld": "743",
"subscriberAddrid": 743, < Terminal ID "notifierNumber": "301",
"subscriberNumber": "301" < Privat phone number "subscriberAddrld": 743,

} "subscriberNumber": "301",

}

GET: Check data of all subscriptions of this terminal
GET h’r’rps://DOMAIN_REST/res’r/subscrip’rions?=&where=’rermino|ld.eq(-)
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EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
AUTO-PROVISIONING"

2. Provision the phone.

a. PUT: Make ready the provisioning the phone. Cc. Response
PUT https://DOMAIN_REST/rest/terminals/321.provision 200 OK
{ & The body must be empty! {

"provisioningOption": "an IP-Phone”,

"status": 200,

"link": "csc:0tc:2970b736a05911789@CLID_AS7POC2*",
"accountlD": "otc@CLID_ASV7",

"password"; "2970-b736-a591-1789"

}

b. PUT: Send an email fo the user with installation instructions.

PUT https://DOMAIN_REST/rest/terminals/321.mail 200 OK
{} < The body must be empty! No body
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EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
URL-PROVISIONING"

»  Provisioning a "3 Party SIP-Phone" via the REST APl can be o
tedious work, as every manufacturer has different parameters
that need to be configured.

» The type of parameters may also differ from phone type to phone type of the same manufacturer.
» The different parameters are represented in the "Terminal Attributes'.

» The following instructions are just a guideline.

1. Provision only 3@ party SIP-phone types that can be provisioned via the Portal Ul
- You can evaluate all needed terminal attributes and their values.

2. Assign via the Portal Ul the desired phone type and read out all generated Terminal Attributes.
a) Give this phone a unigue name that you can search via the REST API, e.g.: "test phone xyz".
b) Get the terminal ID and type of the phone "test phone abc"

GET https://DOMAIN_REST/rest/terminals2=&where=name.like ('test phone abc')&properties=id,type

c) Get all terminal attributes that were generated for the phone "test phone ab"
GET https://DOMAIN_REST/rest/terminal Attributes2=&where=terminalld.eq(321)

d) Use the parameter "type" and all listed terminal attributes for your provisioning.
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EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
URL-PROVISIONING"

»  Provisioning a "3 Party SIP-Phone" via "URL-Provision" is almost
identical to the "Auto-Provisioning'.

» The only difference lies in the provisioning type terminal
attributes.

- This example shows just the differences in the terminal
attributes.
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EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
URL-PROVISIONING"

» For this REST APl example a Yealink T40 G is chosen.

» Assign a phone Yealink T40 G with name "test phone
Yealink T40G" to a PBX Extension the REST APl has

access rights fo.

a. GET: Get the terminal type and ID of this test phone. a. Response

GET https://DOMAIN_REST/rest/terminalse=&where=name.like (test phone Yealink 200 OK
T40G') & properties=id,type {
"terminals"; |
{
"id": 322,
"type": "yealinkT40G" € Remember this type for:
11} » The phone type creation via REST API.
b. GET: Get the terminal attributes of this test phones b. Response
GET https://DOMAIN_REST/rest/terminalAttributes2=8&where=terminalld.eq(322) 200 OK
{ The whole list of terminal attributes are returned
"terminalAttributes™: ... for this Yealink T40G with URL-provisioning.
Example: Yealink T40G |Termino| Attribute Name |Vo|ue |Remork
Mandatory terminal attributes for provisionOpt "manual" Provisioning type
URL-Provisioning oneTimeCode "'e62a44f54b95cc14" Last created one fime code
Terminal attributes needed for the webAdminname "admin” Admin username
correct working of this phone type. webAdminPassword "crypt:ejHpabgU7" Encrypted admin password
webUsername "user" User username
Note: fkey1 "line/743//301 User One" Aftributes with instructions for configuring
The names and values can change  attrDisplayFirstPageOnly "false" the first configurable function key of the

according the selected phone type.  attrPhoneFirstPageOnly "false" phone.
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EXAMPLE CODE: TERMINAL TYPE "3RP PARTY SIP-PHONE,
URL-PROVISIONING"

1. Assign a phone type "3rd Party SIP-Phone, URL" to an b. POST: Create the terminal aftributes for the correct working of this

address. phone type
POST https://DOMAIN_REST/rest/terminal Attributes
a. POST: Create the tferminal Yealink T40G. { )
. L "terminalld": -,
- Equal as with auto-provisioning N ]
"value": "admin" € Mandatory valuel!
b. POST: Create the mandatory terminal attributes for URL- }
.o . . {
provisioning. "terminalld"; 828,
POST https://DOMAIN_REST/rest/terminal Attributes ‘name": "webAdminPassword”,
"value": "'mySecretPw" < Insert a secure password!
{ }
"terminalld”; §28,
'name"; "provisionOpt", { ) ) )
"value": "manual” € Mandatory valuel! terminall’: 828,
} name": "'webUsername”,
‘ "value": "user" < Mandatory value!
terminalld”: §28, )
name": "oneTimeCode", t )
"value": "e62a44f54b95cc14" € Requirement of the value: "Termm"o!llfclzl( : ’:
} » Minimum length: 16 char elE o LI,
» Random string composed of: "value": "line/743//801 UserOne" € The value composes:
» Small letters: [o-7] } "line/<ADDRESS_ID>//<PRIVATELNUMBER>
» Digits: [0-9] <EXTENSION NAME>"
{
GET: Check data of all terminal attributes of this terminal. "terminalld"; 828,
"name"; "attrDisplayFirstPageOnly",
GET https://DOMAIN_REST/rest/terminal Attributes2=&where=terminalld.ec (828) "value": "false”
}
{
"terminalld”: 828,
name": "attrPhoneFirstPageOnly"
1 c.—d. & 2.a.-.b. These steps are equal to auto- "value": "false”
}

provisioning.
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EXAMPLE CODE: DELETE A PBX OR PBX EXTENSION

aare
net)

» Delete a PBX or PBX Extension.

» No REST request exists that deletes a PBX or PBX Extension with all its associated

instances of the available objects.

» Deletfing just the OrgUnit of a PBX leaves a lot of garbage in the database DB.

» Unwanted side effects of garbage in the DB database cannot be ruled out.

» Finding all associated instances and deleting them one by one needs a lot of
code in a customer's CRM application.

Delete a PBX or PBX Extension via the Portal Ul.

PBX List

‘D Name: test X

Description < Member of

B R TS

Extensions: PBX REST Test

Dashboard

o Extension: 301 X
at

nt C//D b Dial In N mber Displayed \/aicema// R

& Eden PEXUea Public Number

H imei
= == T

Display:
Name
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EXAMPLE: USEFUL PBX & TERMINAL COMMANDS
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EXAMPLE CODE: FORCE A PHONE TO RE-DOWNLOAD ITS CONFIG

» Force a phone to re-download ifs
configuration

» Are-download may become necessary for a set of terminals,

e.qg. ifs phone template changed.
» Proposed process:

1. Send a GET request with the desired query to obtain the
list of ferminals matching.

2. Send the nofify request for each of them one by one.

a. PUT: Send a nofification to the phone to re-load its

PUT https://DOMAIN_REST/rest/terminals/310.notify

{ & The body must be empty!

a.

Response

200 OK

No body

Check if the device reloads its configuration
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EXAMPLE CODE: LIST ALL TERMINALS OF A PBX EXTENSION

» Check all terminals assigned to a PBX
Extension OrgUnit.

» GET: List terminals of a PBX Response
GET https://DOMAIN_REST/rest/terminalse=&where=orgUnitld.eq(523) 200 OK
{
"terminals"; |

{

-
{

}
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EXAMPLE CODE: SET THE TIME ZONE OF A PHONE

» Set the Time Zone of a Phone.
» The default time zone is defined by the PBX.
» If a phone needs a different fime zone, then a terminal
attribute "timezone" must be present or created.

» POST: Create a time zone terminal attribute Response
POST https://DOMAIN_REST/rest/terminal Attributes 200 OK
{
"terminalld"”; 821, "name": "timezone",
"name": "ftimezone™, "value": "timezone01",
"value": "timezone01" "id": 1182,
} "terminalld": 321
}
» PUT: Assign a different time zone Response
PUT https://DOMAIN_REST/rest/terminal Attributes/1182 200 OK
{ No body
"value': "timezone07"
}
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EXAMPLE CODE: SET THE RINGING TONES OF A PHONE

» Set the ringing tones of a Phone.

» The default time zone is defined by the anSwitch V7 system.
» If a phone needs a different ringing tones , then a terminal

attribute "alertinternal or "alertExternal" must be present or
created.

» Check via Portal Ul page "Phone related features" if the e——— Source oteaton
phone type supports the setting of ringing tones.
External Call
» POST: Create the ringing fone terminal attributes Response
POST https://DOMAIN_REST/rest/terminal Attributes 200 OK
{ {
"terminalld": B2, "name"; "alertinternal’,
"name"; "alertinternal’, "value": "1",
"value": "1" "id": 2081,
} “terminalld"; 321
{ }
"terminalld"”; 821, {
name": "alertExternal”, name": "alertExternal’,
"value™: "1" "value™ "1",
} "id": 2082,
"terminalld": 321
1
» PUT: Assign a different internal ringing tone Response
PUT https://DOMAIN_REST/rest/terminalAttributes/2081 200 OK
{ No body

walue™ "7"

}
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EXAMPLE CODE: GET THE VOICE MAIL MESSAGES

» Get the Voice Mail Messages of a PBX
Extension.

» The VoiceMail messages are associated to the Address ID of
the PBX Extension.

a. GET: Get all Voice Mail Messages of a PBX Extension a. Response
GET https://DOMAIN_REST/rest/ < 200 OK
audioFiles?wher‘e=addr‘essId.eq(-) .and(type.like(_' )) {
No bodly \ "qudioFiles™: [
{
number": "301

"Hime'™: 1654692548289,
"duration": 4760,

"id": 134, € Message ID of the audio file to download.

"addressld": 743,
"newMessage": frue

3
... Further audio file IDs
1}

b. GET: The audio file of a VoiceMail message b. Response
GET https://DOMAIN/rest/audioFiles/134.wav 200 OK
No body Binary code The body of the 200 OK response contains the audio-

stfream as binary code that must be saved to a file with
extension * WAV.
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EXAMPLE CODE: GET A CALL RECORDING ORDERED VIA CSTA

» A CTl application orders a call
recording via the CSTA protocol and

download the recorded file via REST API.

a. A CTl application orders a call recording with the CSTA method
"recordMessage”.

b. In the response of the anSwitch V7 CTl server the message ID of
the recorded audio file is contained, e.qg.

=

<RecordMessage>
<callToBeRecorded>
<callID>xxx</callID>
<deviceID>dddd</deviceID>
</callToBeRecorded>
<messageID>123456</messageID>
</RecordMessage>

NOoOupbh WwN

c. GET: When the call is finished the CTl application can download
the recorded audio file.

C. Response

GET https://DOMAIN_REST/rest/ -
audioFiles?where=addressId.eq(123456)

200 OK

No body

Binary code

The body of the 200 OK response contains the audio-
stfream as binary code that must be saved to a file with
extension *,WAV.
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EXAMPLE CODE: UPLOAD MUSIC ON HOLD FOR A PBX

aare
net)

» Upload Music on Hold MoH audio file for

a PBX.

» The default MoH is defined by the anSwitch V7 system.

a. POST: Create a new audio-file instance.

POST https://DOMAIN_REST/rest/audioFiles

"type": "static”,
"addressld": 0

}

b. PUT: Upload the MoH audio file.

PUT https://DOMAIN_REST/rest/audioFiles/247 .wav

Set the headers:

» content-type: audio/wave

» content-length: 1234567890 - size of the
audio file.

c. POST: Create a MoH OrgUnit attribute for the PBX.

POST https://DOMAIN_REST/rest/orgUnitAttributes

{
"orgUnitid"; 519,
"name": "'musicOnHoldId",
"value": "247"

}

»

If a PBX needs a different MoH, then a OrgUnit attribute

"musicOnHoldld" must be present or created for the PBX.

a. Response

200 OK
"id": 247, & This is the audio file ID.
"type": "static”, » It must be contained in the uploaded audio file
name.

"addressld": O,

» Itis the reference for the PBX MoH audio file.

b. Response

200 OK

No body

C. Response

200 OK

{

"name"; "musicOnHoldld",
"value™ "139",
"id": 778,
"orgUnitld": 519
}
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EXAMPLE CODE: MANAGE CALL FORWARD CF

Address Forward Forward
» Manage Call Forwards CF. Address o . o o
»  Every call forward of an PBX Extension is configured in an own number: 301 %.W addressId: 743
inst f obi tE ds" (like th tHribut f g OrgUnit name: User One type: cfu —O type: cfnr
instance of object "Forwards” (like the attributes of a Orguni destination: *86 destination: 0987654321
or terminal). delay: 0 delay: 25000
inactive: false inactive: false
a. GET: Get the instance ID of private number 301 a. Response
GET https://DOMAIN_REST/rest/ < 200 OK
addresses?where=number.like('301").and(orgUnitId.eq(523))&properties=id {
No body ‘ "id": 743 € Remember for configuring the call forwards.
}
b. GET: List all Call Forwards CF of private number 301 b. Response
GET https://DOMAIN_REST/rest/forwards?where=addressId.eq(743) 200 OK
No body ‘ Empty response or list of already configured | = Check if the desired CF is already configured:
CFs. => If not, then the CF instances must be created.
= If yes, then remember its instance-id.

c. POST: Set new active CFU to 0876543219 for private number 301 C. Response
POST https://DOMAIN_REST/rest/forwards 200 OK
{ {
"addressld": 743, "id" 692, € Remember for configuring the call forwards.
type'": "cfu", < Select the desired CF type "type": "cfu’
"destination":"0876543219", < Any dialable number (*86 for the own "destination": "0876543219",
VoiceMail Box) "delay": 0,
"delay": 0, & For CFNR define the delay in "inactive": false,
milliseconds. "timetableld": 0,
"inactive": false < Activate the CF "addressld": 743,
} }
d. PUT: Inactivate CFU to 0876543219 for private number 301 d. Response
PUT https://DOMAIN_REST/rest/forwards/743 200 OK

{"inactive": true } < Deactivate the CF {...."Inactive": true, ...}
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EXAMPLE: MANAGE CONTACTS

EXAMPLE OVERVIEW: MANAGE CONTACTS
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» Goal:
» Manage the contacts of a PBX

» Data to prepare:
O Name of the of the PBX
O Name of the PBX extension
O Data of new contact
L0  Name
0 Number
0 Short number

» Overview of the execution steps:

1. Get the last 5 CDRs of "Front Desk"
a. GET: Get the OrgUnit ID of extension with name "PA-PBX-
OAX89001".
b. POST: Create new contact with short number "Aarenet
Front Desk".

2. Manage contacts

a. PUT: Change a property of a contact, e.g. number
b. DELETE: Delete a contact

3. Search contacts

Overview of involved DB objects

Orgunit
id: 26
type:
name:

pbx
PBX Comp. A

-

OrgUnit
id:
parentId:
type:
name:

489
26
extension
Front Desk

Contact
id:
name:

orgUnitId:
telNumber:

shortNumber: 800

12

"Aarenet Front
Desk"

26
+41319802811
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1. Create a Contact for a PBX.
a. GET: Get the OrgUnit ID of PBX with name "PA-PBX-0AX89001". a. Response
GET https://DOMAIN_REST/rest/orgUnits?where=name.like('PA-PBX- 200 OK
0AX89001")&properties=id {
No body "orgUnits": [
{
"id" 26 € OrgUunit ID of the PBX, save for later use!
}
]
}
b. Get: Check if contact "Aarenet Front Desk" already exists for b. Response
GET https://DOMAIN_REST/rest/contacts?where=name.like('Aarenet Front 200 OK
Desk').and(orgUnitid.eq(26)) {
No body "contacts": [] - Empty brackets [ = this contact doesn't exist.
}
c. POST: Create new contact with short number "Aarenet Front c. Response
Desk".
POST https://DOMAIN_REST/rest/contacts 200 OK
{ {
"orgUnitld": 26, "name"; "Aarenet Front Desk",
"name": "Aarenet Front Desk”, < New contact ID
"telNumber": "+41 31 98028 11", - +isnot a valid character "type": null,
"shortNumber": "800" - Use 00 instead or the valid international "orgUnitld": 26,
} prefix. "telNumber": "+41 31 98028 11",
"teINumberNormalized": "41319802811", | > The normalized number will be dialed when the short
"shortNumber": "800" number is dialed.
} If a "+" was configured it is stripped and the
destination cannot be found.
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EXAMPLE CODE: CHANGE, DELETE OR SEARCH CONTACTS

2. Manage a contact
a. PUT: Change a property of a contact, e.g. number a. Response

PUT https://DOMAI N_REST/res’r/con'racts/. 200 OK

There is no return of the changed instance.
= Re-read the instance for checking the new value.

"telNumber": "0041319802811",

}

GET h’r’rps://DOMAIN_REST/res’r/coniucfs/.

No body
b. DELETE: Delete a contact b. Response
DELETE https://DOMAIN_REST/rest/contacts/ii2 200 OK
No body There is no return of the deleted instance.
= Re-read the instance for ching if it is deleted.

3. Search contacts
a. Get: Search the contacts for names that start with "Bo".

GET https://DOMAIN_REST/rest/contacts?where=name.like('Bo%").and(orgUnitld.eq(26))

No body

b. Get: Search the contacts for names that start with "Bo" and the phone number starts with "079".
GET https://DOMAIN_REST/rest/contacts?where=name.like('Bo%").and (telNumber.like( '079%")).and(orgUnitld.eq(26))

No body
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EXAMPLE OVERVIEW: LIST CDRS OF A PBX EXTENSION

» Goal: » Overview of involved DB objects
» Get the last 5 CDRs of user "Front Desk"

» Data per call to be provided:

»  Id of the CDR i
» Destination number type:  pbx
» Connection date/time e PR CEp. A
» Callrelease date/time OrgUnit
> Chorge parentId: 26
type: extension
> DOTO _I_O prepgre: name: Front Desk
[0  Name of the of the PBX @ @
OO0 Name of the PBX extension
» Overview of the execution steps: @NCDR
n " id:
1. Get the last 5 CDRs of "Front Desk . =

a. GET: Get the OrgUnit ID of extension with name "PA-PBX-
0AX82001".

b. GET: Get the OrgUunit ID of extension with name "Front
Desk".

c. GET: Get 5 CDRs of the PBX extension "Front Desk".
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EXAMPLE CODE: LIST CDRS OF A PBX EXTENSION

1. Geft thelast 5 CDRs of "Front Desk"
a. GET: Get the OrgUnit ID of PBX with name "PA-PBX-0AX89001". a. Response

GET https://DOMAIN_REST/rest/orgUnits?=&where=name.like('PA-PBX-0AX89001") 200 OK
No body ‘

"orgUnits": [
{

"id": 26, € OrgUnit ID of the PBX, save for later use!

"parentld": 25

}
]

}

b. GET: Get the OrgUnit ID of extension with name "Front Desk" of b. Response
PBX "PA-PBX-0AX8900T1".

GET h’r’rps://DOMAIN_REST/res’r/orgUnits?=&where=nqme.like(- 200 OK
).and(parentId.eq(26))
No body "orgUnits": [

€ OrgUnit ID of the PBX extension, save for later use!

"parentld": 26
}
]
}
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EXAMPLE CODE: LIST CDRS OF A PBX EXTENSION
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1. Getthe last 5 CDRs of "Front Desk"
c. GET: Get 5 CDRs of the PBX extension "Front Desk"

GET
https://DOMAIN_REST/rest/cdrs?where=accOrgUnitld.eq(28)&limit=5&ascending
=id&properties=id,destNumber,timeConnect,timeEnd,chargePublic

No body
NoTe For details about the available CDR fields, see the
training documentation:
"Rating & Call Detail Record CDR"
(doc id: training_as7_706_sys_rating_cdr)
No-l-e Do not use this type of obtaining CDRs for billing

purposes!
- Large queries may block the database!
- Use the CSV formatted CDR files for this task.

C.

Response

200 OK

{

"cdrs™: [

"id": 2420,

"destNumber": "330",
"timeConnect": 1692364701534,
"timeEnd": 1692364704230,
"chargePublic™: 0.0

"id": 2427,

"destNumber": "0123456789",
"timeConnect": 1694436798192,
"timeEnd": 1694436813831,
"chargePublic": 103.007845565

"id": 2429,

"destNumber": "0123456789",
"tfimeConnect": 1694436900075,
"timeEnd": 1694436913697,
"chargePublic": 103.00683370333333

"id": 2430,

"destNumber": "0123456789",
"timeConnect": 1694437569320,
"timeEnd": 1694437591917,
"chargePublic™: 103.01133616166666

"id": 2432,

"destNumber": "300",
"timeConnect": 1695044262452,
"tfimeEnd": 1695044269466,
"chargePublic": 0.0
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EXAMPLE CODE: OTHER CDR COLLECTING COMMANDS

» Get the CDRs of multiple OrgUnits.

GET https://DOMAIN_REST/rest/cdrs ?where=accOrgUnitId.in(28,32)
No body ‘

» Get all CDR's of PBX from last month.
» Transform the start and end dates to UNIX timestamp in
milliseconds.
(https://www.unixtimestamp.com/)
» timeStart  1.10.2023 00:00 - Timestamp: 1696111200000
» timeEnd 1.11.2023 00:00 = Timestamp: 1698793200000

GET

https://DOMAIN_REST/rest/cdrs?where=accOrgUnitld.eq(28).and(timeStart.ge(16
96111200000)).and(timeEnd.le(1698793200000))

No body ‘
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